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Software License Agreement: 
The use of this software product is limited to the terms and conditions 
below. Use by the purchaser of Crisis Controller©™ Alarm Monitoring 
software indicates acceptance of these terms.

Grant of Rights: 
This software may only be used on the computers for which it is licensed. 
This license may not be transferred from its original site. You may not 
copy or otherwise distribute this software, except to make a backup 
copy. You may not modify, alter, or transfer the software in any way.

Limitation of Liability: 
Licensor shall not be liable for any claim or demand by Licensee for 
damages of any kind, including, but not limited to special, general, 
incidental, direct or consequential dam-ages, for loss of business 
profits, business interruption, loss of business information, or any other 
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if prohibited by the laws of your jurisdiction.

General: 
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validity and enforceability of any of the remaining provisions. The laws of 
the State of Colorado shall govern this Agreement.
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Standard Time) or 
Emai us 24/7.

303-226-4799 
support@actall.com
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IMPORTANT! 

SOFTWARE REGISTRATION CARD MUST BE FILLED OUT 

Please fill out and return the Software Registration Card. 

Actall® Security Products Technical Support needs the information on this card 

to verify authenticity of requests for service and to be able to provide timely 

and accurate technical assistance to our customers.  

In addition, it is in the customer‘s interest for Actall® to have a duplicate record 

of software serial numbers and Hardware Key codes. It also protects the cus-

tomer if questions of software licensing arise. Additional information, such as 

computer type, operating system, and general application information can save 

a great deal of valuable time in troubleshooting and responding to customer 

needs. 

PASSWORD SAFEGUARD 
WARNING! 

Please note that factory passwords for the Supervisor, Operator, and Admin are shown 

on the initial password screen for the purpose of system setup only. For proper 

security, passwords should be immediately changed. If a hard copy is necessary for 

future reference it should be stored in a secure location. 
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Attendants 
 

Tools > Attendants 

 

 

 

 

 

 

 

 

 

 

 

Attendants operate and control all functions of the Crisis Controller software.  

Users are entered into Crisis Controller at Admin, Operator, and Supervisor lev-

els.  

 

 

Passwords are never displayed in plain text, so lost passwords must be deleted and 

new ones assigned. 

 

Add Button  Use this button to add in a new attendant. 

 

Edit Button  Use this button to edit and exciting attendant. 

 

To change passwords, highlight the desired user and press Edit Button, then enter a 

new password. 

 

Delete Button  Use this button to delete a attendant from the system. 

 

Attendant types 

Admin attendants 

These attendants can only assign or de-assign  PMT and print reports. All other 

functions are inaccessible   

Operator attendants 

These attendants can only do alarm monitoring. Operators can not stop Alarm 

Monitoring or exit the system.  
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Attendants (continued) 

Under alarm monitoring mode there are access rights that can be assigned. 

 

Tabs Access   View Status and System Message tabs 

 

Toggle Groups  Enable and disable Transmitter Groups and start and 

   stop the Guard Tour option. 

 

Time Mode   Change the Time Mode (Day, Evening and Night). 

 

Simple Acknowledge/Reset  Setting this option does not show the Action Taken/

   Notes window. 

 

Supervisor attendants 

Users set at this level have full access to all system options. They can start and 

stop Alarm Monitoring as well as perform system configuration.   

 

 Adding a Attendant 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

When adding attendants the following information is required: 

 

Name:  Attendants login name (ex: Sgt.Smith) 

 

Password:  Attendants password. (Blank password are permitted) 

 

If a password is forgotten simply create a new password for the attendant. 
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Attendants Add (continued) 

 

Role 

This section indicates to the system what right the attend will have. 

 

Admin  

These attendants can only assign or de-assign  PMT and print reports. All other 

functions are inaccessible   

Operator attendants 

These attendants can only do alarm monitoring. Operators can not stop Alarm 

Monitoring or exit the system.  

Under alarm monitoring mode there are access rights that can be assigned. 

Supervisor attendants 

Users set at this level have full access to all system options. They can start and 

stop Alarm Monitoring and do system configuration.   

 

Additional Permissions 

 

This section allows you to assign rights to Monitoring mode functions. 

 

Toggle Groups 

Allows the attendant to enable and disable Transmitter Groups and start and 

stop the Guard Tour option. 

 

Change Time Mode 

Allows the attendant to change the Time Mode (Day, Evening and Night). 

 

View Status Info 

Checking this will allow the attendant to view the FPT Status Tab. 

 

View System Messages 

Checking this will allow the attendant to view the System Messages Tab. 

 

View Tracking Info 

Checking this will allow the attendant to view the PMT Status Tab. 

 

Allow Simple Ack/Reset 

Setting this option does not show the Action Taken/Notes window. 
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Attendants (continued) 

 Operators 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
Operators are individuals whose primary function is to monitor the PALS Alarm 

Monitoring Center. In the event of an alarm, Operators will access system infor-

mation and monitor responses.  Once logged in as an Operator, the monitoring 

screen cannot be minimized or exited by the Operator. 

 

Operator-level personnel may be authorized to access various levels of informa-

tion, as well as perform several selective tasks.  The degree of access is deter-

mined by options set by a Supervisor on the Adding a User or Editing an Atten-

dant screen. 

 

Primary Operator Tasks 

 

Operators respond to information generated by the Crisis Controller software.  

Information about the system is displayed on the system monitor in Windows®-

based information screens.  Incoming alarm or trouble messages appear in the 

display with optional warning sounds, configured for each device.   

 

Operators are responsible for acknowledging incoming alarms and determining 

that proper responses are generated.  This can include alarm verification and/or 

documentation of incoming data, depending upon the operating requirements of 

the Owner. 
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Attendants (continued)  

Supervisors 

Supervisors have access to all features. Supervisor-level personnel can access 

all menus.  This permits them to configure the system and control user access 

levels and passwords. 

Supervisory level access should only be granted to people who have been thor-

oughly trained on the system, as they have the capability of changing the opera-

tion and parameters of the system. 

Primary Supervisor Tasks 

 

Supervisors create and assign passwords to Operator and Admin users. 

Programming Transmitters 

Supervisors may add or delete Transmitters, Receivers, Repeaters, RF locators 

and any other hardware from the system.   

Turning the system off 

Only Supervisors with an Actall generated special user and password can exit 

the system once it has been activated.  

Additional supervisory functions 

System Supervisors have access to data that is not available to Operators or 

Administrative Users.  For example, the Supervisor is authorized to access and 

modify account data information, and to review and modify information regard-

ing system hardware. 

 

Supervisors can import and edit site maps.  Supervisors can set Transmitter 

programming, including how the system will respond to each Transmitter. 

Supervisors should log out of the system before turning monitoring duties over to 

Operator or Admin level personnel. 

System Configuration: 

These menus include critical Supervisor responsibilities.  Hardware and account 

information is managed through features used to configure the system.  Super-

visors may find it helpful to remember that most program functions of the Crisis 

Controller software are designed to present them first with a drop-down list of 

information.  From the list, Supervisors may make selections that activate pro-

gramming or data forms that can modify information in the list.  This drop-down 

list architecture is followed in all features of the program, and is particularly 

pertinent to configuration tasks. 

As a Supervisor, prior to exiting either the Alarm Monitoring Screen or the applica-

tion, all alarms and troubles currently displayed should be acknowledged and reset.  

If this is not done, all current alarm information will be lost.  In network versions of 

Crisis Controller, Supervisors may perform their duties on an Administration ma-

chine. 
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Receivers 
 

Actall Serial Receivers are where all transmissions with alarm information from 

FPTs (Fixed Point Transmitters) and PMTs are received, interpreted, and sent to 

the Crisis Controller software. 

Adding/Changing a Receiver 

Devices > Receivers 

 

 

 

 

 

 

 

 

 

 

When configuring a Serial Receiver, you must first enter the following informa-

tion: 
 
Name :   Assign a name for the system to identify this hardware (i.e. Actall 

  Receiver).   

 

Model: The make of the receiver (The default value is ‗Inovonics‘). 

 
Station: Select the station that to which the receiver is physically attached.  

Stations can be viewed in the drop down list. 

  

Enable: If the Receiver needs to be disabled temporarily, clear the check 

  box; otherwise this box should always be checked. 

 

 By disabling the Receiver, alarm information will not be received while in Alarm Monitoring.  

Also, this will affect test alarm receiving during check in and check out via the barcode based 

user assignment on page 12. 
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Receivers (continued) 

Property Code:  Serial Receivers ―look‖ for Transmitters with a matching 

―property code‖ (1 to 32) and a system ID number.  This num-

ber accompanies transmissions from all Transmitters pro-

grammed to this Receiver and is used to differentiate transmis-

sions from different systems which may be operating in the 

same area. 

 

Ignore Other Prop Codes:  If the Ignore Other Property Codes check box is se-

lected, only Transmitters with a matching property code will be 

accepted, regardless of the transmitters programmed IDs or 

which Receiver they were programmed from.  Non-matching 

transmissions are ignored. 

 
Port: Identify the Com port to which the Receiver is connected 

 

Comments:  The comments box is available to permit system programmers and 

system users to record pertinent information about the Receiver or 

its application.  For example, ―Actall Receiver 1 is located on the 

Monitor1 machine‖  
 

 

If more than one Receiver is in the system, it is important that the Receivers are 

marked with their property code.  When Transmitters are programmed or when 

there is a Receiver problem, the Crisis Controller® software uses the property code 

for all references. 

 

 

If the property code is changed after Transmitters have been programmed, all 

Transmitters must be reprogrammed to reflect the new property code.  This in-

cludes all related Repeaters and RFLs (Radio Frequency Locators). 
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Pager Services 
 

The Pager Service contains information regarding the Pager Transmitter and the 

pagers associated with the pager transmitter. 

 

Adding/Changing A Pager Service 

Devices > Pager Services 

 

 

 

 

 

 

 

 

 

 

When adding a pager service the following settings must be entered: 
 

Name:  Select the name of the system to identify this hardware (i.e. Actall 

 Page Alert).  

  
Model:   The make of the Page Transmitter. 

 
Station:   Select the station to which the Page Transmitter is physically con-

nected.   Stations can be viewed the in the drop down list 

 
Port:  The COM port to which the Page Transmitter is attached. 
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Pager Service (continued) 

 

Adding/Changing a Pager 
Pagers (typically identified by the user assigned to the pager) are programmed 

into the Crisis Controller® software.  They can then be assigned to specific 

Transmitter areas, and/or can receive pages sent manually through the Crisis 

Controller® software.  Prior to assigning a pager, each individual pager must 

first be defined. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Name:  Enter the name to be assigned to the pager. (ex: Group Page) 

 

Number: The Cap-Code of the pager (the Cap Code is generally displayed 

when the pager is turned on). 
 

Test Button: Pagers may be tested after they are entered. To test a pager se-

lect the pager form the list and press the test button.  The pager 

being tested must have the test sent from the system that the 

Page Transmitter is physically attached to. 
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Camera Systems 
 

Crisis Controller can directly interface with the Vicon Nova, Sensormatic and 

Phillips camera switchers. This allows Crisis Controller® to activate specified 

cameras when an alarm occurs based on PMT location or Fixed Point Transmitter 

locations.  Other brands of camera switchers may be activated by utilizing the 

Actall SIO32 Contact Board. 

  

Adding/Changing A Camera Switcher 

Devices->Camera switchers 

 
 

 
 
 

 
 

 
 

 

 

 

 
When adding a camera switcher the following information must be entered: 

 
Name: Assign a name for the system to identify this hardware.  

  

Model: The make of the camera switcher (Choose from drop down list). 

 

Station: Select the station to which the camera switcher is physically con-

nected.  Stations can be viewed the in the drop down list 

 

Monitor: The Monitor to display the camera on. 

 

Port:  The COM Port to which the camera switcher is attached. 
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Cameras  
 

Adding/Editing A Camera 

Devices->Camera switchers->Edit->Add 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When adding a camera the following information is required: 

 
Name: Enter the name to be assigned to camera. 

 

Number: The camera number on the switcher. 

 

Test Button:  Camera may be tested after they are entered. To test a camera 

select the camera form the list and press the test button. 

 

Camera switcher cable connections 

 Sensormatic camera switcher connection. 

 Connect to the Crisis Controller CPU by a standard RS232 serial cable. 

 

 Vicon Nova camera switcher connection. 

 Connect to the Crisis Controller CPU by a standard RS232 serial cable. 

 

 Phillips camera switcher connection. 

 Connected to the Crisis Controller CPU by a NULL modem RS232 serial cable. 
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Intercom Systems 
 

Intercom Systems open audio paths between the main station and the sub-

station to allow for communication. 

 

Adding/Editing an Intercom System 

Devices > Intercom Systems 

 

 

 

 

 

 

 

 

 

 

When Adding in an intercom system the following is required. 

 
Name: Assign a name for the system to identify this hardware (i.e. Stento 

9600 control).   

 

Model: Type of intercom being used. (chosen form drop down list) 

 

Station: Select the station that physically has the intercom system at-

tached.  Stations can be viewed in drop down list. 

 

Port:  COM port to which the intercom system is connected. 

 

 

 

 

 

 

 

 

Users can select between Stentofon and multiplexed Stentofon systems.  The 

Stentofon intercom system will support up to 96 stations.  The multiplexed Sten-

tofon system can support up to 9 Stentofon  modules, for a total of 864 stations.    
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Intercom Systems (continued) 

 

Adding/Changing An Intercom Station 

Devices > Intercom Systems >Add (or Edit)  > Add (or Edit) 

 

Intercom Stations are physical channels on the Intercom System.   

 

 

 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 

 

 

 

 

When Adding in an intercom stations the following is required: 

 

Name: Assign a name for the system to identify this hardware (i.e. kitchen 

intercom).   

  

Number: Relay number on relay card. 

 

Test Button: Stations may be tested after they are entered.  To test a pager se-

lect the pager form the list and press the test button. 

 

Intercom stations can be associated with alarms from fixed point locations or IRT 

locations.  The software automatically switches intercom connections when new 

alarms occur. The Crisis Controller software refreshes this connection periodically 

(in case the intercom connection is manually changed).   
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SIO32 Module 

Adding/Changing A Relay Card 

Devices > Relay Cards > Edit 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

The SIO32 module is a multi-functional relay board that will permit system in-

stallers to activate up to 32 output devices or allow up to 32 inputs, or any 

combination of inputs and outputs in groups (―banks‖) of 8.  When Adding a re-

lay Card the following information is required: 

 

Name: Assign a name for the system to identify this hardware (i.e. SIO32 

  board #1)  

 
Model: Type of relay board 

 
Station: Select the Monitoring Station that physically attached to the Relay 

Board.  Stations are selected from the drop down list 

 

Port:  Identify the Com port to which the relay board is connected. 

 
Board  Number:  The Board Number (1-8) is designated by the DIP switch set-

t i ngs  on  the  S IO32 

board.   

  

Banks must be designated as ei-

ther input or output using the DIP 

switches on the SIO32 board.  

[See Actall® Installation Manual 

for DIP switch configuration.] 
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SIO32 Module (continued) 

Adding Relays 

Devices > Relay Cards > Add > Add 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Relays are contact closures that are normally open or normally closed, depend-

ing on how the relay is wired.  When adding  a relay the following information is  

required: 
 

Name: Assign a name for the system to identify this relay. 
 

Number: Relay to be activated on the SIO32 board. 
 

Duration: The action of the relay.  The four options are as follows:   

 

  *  Until Acknowledge—Set relay until associated alarm is acknowl-

edged. 

 *  Until Reset — Set relay until associated alarm is reset. 

  *  Momentary — Relay is set for short duration (less then 3 sec-

onds) 

 *  Toggle— Relay state is changed. 
 

Test Button:  Relays may be tested by selecting the relay from the list and  

pressing the test button.  The relay will momentarily change states. 

Adding Inputs 
 

Inputs are dry contacts on the SIO32 re-

lay/input board that can be normally 

open or closed.  The first step to creating 

an input for the SIO32 relay/input board 

is to create profiles for the inputs. Pro-

files determine the action to be taken 

when an alarm condition is matched. 

Profiles allow global changes to input ac-

tions to all inputs assigned to the profile. 
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SIO32 Module (continued) 

Adding/Changing a Profile 

Devices > Input Profiles > Add (or Edit)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General Tab 

 

The following options are available on the General Tab: 

 
Name: The name to identify the input profile (input may use the same  

  profile). 

 
Page on Alarm:  When the alarm is received send a page to the chosen pager. 

 

Page on Acknowledge:  When the alarm is acknowledged send a page to the 

chosen pager. 
  

Page on Reset:  When the alarm is acknowledged send a page to the chosen 

pager. 

 

Sound on Alarm:  When the alarm is received play the chosen sound file. 

 

Sound Continually:  When the alarm is received continue to play the  

 chosen sound file until the acknowledged button is pressed.   
  Note: If  this option is not selected the sound file will play only once. 
  
Auto Acknowledge:  When the alarm is received the system will automatically 

acknowledge and reset the alarm after thirty seconds. 

 
Sound File Name:  The sound file that will play when this alarm is received. Use 

the browse button to select the file to be played on alarm.   

 (Horn.wav is the default sound file) 
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SIO32 (continued) 

Time Mode Tab 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
This Action Tab contains the settings that determine the time mode to receive 

alarms. The three options are Day, Evening, and Night. 

 

Pager Tab 

  
 
 
 
 
 
 
 
 
 

 
 
 
This tab determines what pagers are to receive a message when an alarm is re-

ceived.  To select pagers for to be included press the Edit button and a list of 

pagers will be displayed. Select each pager to receive messages for the profile. 

Once the OK button is pressed, the selected pagers will appear in the Alarm 

Profile Pagers box. 
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Repeaters 
 

Repeaters are transceivers that rebroadcast RF transmissions.  They can be de-

ployed to provide system redundancy and enhanced reliability, or to extend the 

range of transmission.  Repeaters have many of the same parameters as Trans-

mitters.  These parameters are assigned and the Repeater is programmed to a 

Receiver in the same way that Fixed Point Transmitters are programmed. 

 

Adding/Changing a Repeater 

Devices > Repeaters 

 

 

Repeaters are handled like 

FPT devices. Before Repeat-

ers can be added into the 

system an alarm profile and 

template will need to be 

created for the desired 

alarm action. These alarm 

profiles and templates are 

c reated under  the FPT 

menu on the menu bar. It is 

recommended that profiles 

and templates are named to 

reflect what type of trans-

mitter they will be used for. (ie: for the profile, use the name Repeater-

Type1Profile and for the template name it RepeaterType1Template)    
 

Red X  Repeater needs to be programmed. 
 

Blue Check Repeater is programmed. 
 

Add Button Use this button to enter information about new repeaters. 
 

Edit Button Use this button to edit information about an existing   

   repeater. 
 

Delete Button This will delete the selected repeater from the system. 

 

Program Button After all data for the repeater is entered this button is used 

to program the data into the repeater.  

 

Some repeater configuration changes will result in a Red X being display next to 

the repeater in the list. This Red X indicates that the repeater must be repro-

grammed. 
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Repeaters (continued) 

 

Repeater Add/Edit 

 

 

 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 

When adding a Repeater the following information is required: 

 

Template:  Templates are used as a short cut to add transmitter information 

that is common to each repeater added into the system. Choose the 

appropriate template for this repeater.  The template contains configu-

ration settings for the following options:  Name, Contact Type, Check-

in Interval, Supervision Interval, Default Receiver, any relays, inter-

com stations and/or cameras to be activated by an alarm. Templates 

also contain the  Alarm Profile to use.  For more information on tem-

plates and profiles see the FPT template and profile section.  

 

The options that have been added by the template can be modified to meet the 

specific needs for each repeater associated with the profile. 

 
Name:  The is the name to be displayed when an alarm is received for the re-

peater (i.e.: Repeater 2) 

 
ID:  The unique number to be programmed into the repeater. This number is 

generated by the system but may be changed as necessary. 

(Duplicate IDs for any FPT are not allowed by the system). 
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Repeaters (continued) 

 
Location:  The is the description of the location to be displayed when an alarm is 

received for the repeater (i.e.: North West side). 

 

Receiver:  Identifies the receiver that will be monitoring the repeater.  This is 

also used to  assign the repeater the property code under which it will 

report. (For more information on property codes see the receiver sec-

tion).  When multiple receivers are used in the system, select the de-

sired receiver from the drop down list.   

 

Check-in Interval:  This option is used to configure  the repeater for the time 

interval in which it is to send a check-in transmission. 

 

Supervision Interval:  The option is used to tell the Crisis Controller software 

how long to wait for a check-in transmission from the repeater. If a 

check-in transmission has not been received in the allotted time win-

dow an inactivity alarm is posted. 

 

The default configuration for Check In and Supervision is 1 minute and 4 hours, 

respectively.  These times should be changed at installation to accommodate the 

RF Properties specific to the site (number of transmitters, site layout, etc.). 
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Repeaters (continued) 

Alarm Action Tab 

The Alarm Action Tab is where you configure which relays, intercom stations 

and/or cameras that are to be activated during an alarm.  If any relays, inter-

com stations or cameras were chosen in the profile they will be placed into 

there appropriate sections. You may edit the list of relays, intercoms and cam-

eras to customize each individual repeater. 

 

 

 

 

 

 

 

 

Edit Button  Lets you add or remove an item(s) from the list. 

 

Delete Button  To delete an entry select the item to delete and press 

    the Delete Button associated with the list. 

General Tab  

 

Tells the system what to do when an alarm is received.  Page On Alarm, Page 

On Acknowledge, Page On Reset, Sound On  Alarm, Sound Continuously and/or 

Auto Acknowledge. 

Actions Tab  

 

Contains the time periods to alarm in and what alarms to act upon.  Panic, Low 

Battery, Tamper and Inactive alarms for Day, Evening and Night  modes. 

Pager Tab  

 

Contains the list of the pagers that will receive a page when an  alarm occurs. 

 
For more information on Profiles see the FPT Profile section. 
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RF Locators 
RF Locators are transceivers that rebroadcast mobile FPT as well as PMT trans-

missions with additional location information attached to the transmission.  RF 

Locators have the same options as Repeaters and should be programmed ac-

cordingly.. 

Adding/Changing a RF locator 

Devices > RF Locators 

 

 

 

 

 

 

 

 

 

 

 

RF Locators can be programmed to activate relays, Intercom stations and Cam-

eras.  The desired action will occur if a mobile Transmitter or PMT alarms with 

this RF location.  RF Locators MUST be programmed into the system.  RF Loca-

tors are handled like FPT devices. Before RF Locator can be added into the sys-

tem a profile and template need to be created for the desired alarm action. 

These profiles and templates are created under the FPT main menu section. 

Name profiles and templates to reflect what type of transmitter they are for. 
(i.e.: for the profile name it RFLocaotrType1Profile and for the template name it 

RFLocatorType1Template). 

 

Red X  RF Locator needs to be programmed. 
 

Blue Check RF Locator is programmed. 
 

Add Button To enter information about new RF Locators. 
 

Edit Button To edit information about an existing   

   RF Locators. 
 

Delete Button To delete the selected RF Locator from the system. 

 

Program Button After the RFL is configured, this button is used to program 

the RF Locator.  

 

 

Some RF Locator configuration changes will result in a Red X being display next to 

the RF Locator in the list. This Red X indicates that the RF Locator must be repro-

grammed. 
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RF Locators (continued) 

Adding an RF Locator 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 

 

 

When adding a RF Locator the following information is required: 

 
Template:  Templates are used as a short cut to add transmitter information 

that is common to each RF Locator added into the system. Choose the 

appropriate template for this RF Locator.  The template contains con-

figuration settings for the following options:  Name, Contact Type, 

Check-in Interval, Supervision Interval, Default Receiver, any relays, 

intercom stations and/or cameras to be activated by an alarm. Tem-

plates also contain the Alarm Profile to use).  For more information on 

templates and profiles see the FPT template and profile section.   The 

options that have been added by the template can be modified to 

meet the specific needs for each repeater associated with the profile. 

 
Name:   This is the name to be displayed when an alarm is received from the 

RFL (i.e.: North side behind Housing Unit #1) 

 
ID:   The unique number to be programmed into the RF Locator. This num-

ber is generated by the system but may be changed is necessary. (A 

duplicate ID for any FPT is not allowed by the system) 
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RF Locators (continued) 

 

Location:  The location name to be displayed when an alarm is received for the 

repeater, or a PMT or Mobile FPT alarm is received with the RF Loca-

tion id.   (i.e.: North West fence). 

 

Receiver:  Identifies the receiver that will be monitoring the RF Locator.  This is 

also used to  assign the RF Locator the property code under which it 

will report. (For more information on property codes see the receiver 

section).  When multiple receivers are used in the system, select the 

desired receiver from the drop down list.   

 

Check-in Interval:  This option is used to configure the RF Locator for the time 

interval for check-in transmissions. 

 

Supervision Interval:  The option is used to tell the Crisis Controller software 

how long to wait for a check-in transmission from the RF Locator. If a 

check-in transmission has not been received in the allotted time win-

dow an inactivity alarm is posted. 

 

 

 

The default configuration for Check In and Supervision is 1 minute and 4 hours, 

respectively.  These times should be changed at installation to accommodate the 

RF Properties specific to the site (# of transmitters, site layout, etc.). 
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 RF Locators (continued) 

Alarm Action Tab 

This tab allows you configure the relays, intercom stations and or cameras that are 

to be activated.  If any relays, intercom stations or cameras were chosen in the 

profile they will be placed into the appropriate section. You may edit the list of re-

lays, intercoms and cameras to customize each individual repeater. 

 

 

 

 

 

 

 

 

 
 
Edit Button  Lets you add or remove an item(s) from the list. 

 

Delete Button  To delete an entry select the item to delete and press 

    the Delete Button associated with the list. 

 

The  profile that is associated with the RF Locator also contains the following infor-

mation: 

General Tab  

Tells the system what to do when an alarm is received.  Page On Alarm, Page On 

Acknowledge, Page On Reset, Sound On Alarm, Sound Continuously and/or Auto 

Acknowledge. 

Alarm Actions Tab 

Contains what time periods to alarm in and what alarms to receive.  Panic, Low 

Battery, Tamper, Inactive for Day, Evening and Night  modes. 

Pager Tab 

Contains the list of the pagers that will receive a page when an alarm occurs. 

 
For more information on Profiles see the FPT Profile section. 
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FPT (Fixed Point Transmitter) 
 

FPTs are RF transmitters that are reported in a fixed location.  FPTs are manu-

factured in several different form factors, including: 

 

Wall Mount Buttons 

Under Desk Buttons 

Belt Worn Transmitters (Mobile FPTs) 

Contacts (for doors and windows) 

Passive Infra Red motion detectors 

 

All FPT profiles and templates should be configured before configuring all manners 

of FPTs (including Mobile FPTs), RFLs, and Repeaters. 

 

Defining a FPT Profile 

FPT > Profiles  

The configuration in a profile determines how the software will respond when an 

alarm is received by the system. Profiles also allow global changes to the op-

tions to all FPTs that belong to each profile. 

  

Add Button  To add a new profile to the system 

 

Edit button  To Edit the selected profile 

 

Delete Button  To delete the selected profile from the system 
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FPT Profiles (Add/Edit)  

General Tab 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 

 

When adding a Profile the following information is required: 

 
Name:  The name to identify the input profile  (Different FPTs may use the same 

profile) 

 

Page on Alarm:  When the alarm is received send a page to the chosen pagers. 

 

Page on Acknowledge:  When the alarm is acknowledged send a page to the 

chosen pager. 

 

Page on Alarm Reset:  When the alarm is acknowledged send a page to the cho-

sen pager. 

 

Sound on Alarm:  When the alarm is received play the chosen sound file. 

 

Sound on Continuously:  When the alarm is received continuously play the cho-

sen sound file until the acknowledged button is pressed.  Note: If this 

option is not selected the sound file will play only once. 

 

Auto Acknowledge:  When the alarm is received the system will automatically 

acknowledge and reset the alarm after thirty seconds. 
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FPT Profiles (Add/Edit)  

 

Time Mode Tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This tab determines what time period to receive alarms. (Day, Evening, Night) 

  

Pager Tab           Sound Tab 

 
 

 
 

 
 
 

 
 

 
 
 

 
 
 The Pager tab determines which pagers are to receive a message when an 

alarm is received.  A list of available pagers will display when the Edit button is 

pressed. Select each pager to receive messages for the profile. Once the OK 

button is pressed, the selected pagers will appear in the Alarm Profile Pagers 

box. 

 

 The Sound tab will allow the user to customize sounds for different alarm con-

ditions.  The ―horn.wav‖ file is the default sound however you can choose a dif-

ferent sound for a low battery alarm instead of the ―horn‖ sound, allowing staff 

to differentiate between alarms solely based on audible alerts. 
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Defining a FPT Template 
 

Templates are used as a shortcut to add in transmitter information that is com-

mon to the transmitters that are being added into the system. The template 

contains the following information that the transmitter is to be programmed 

with, including: Name, Contact Type, Check-in Interval, Supervision Interval, 

Default Receiver, associated relays, intercom stations and/or cameras to be ac-

tivated by an alarm. Templates also contain an Alarm Profile to use. 

 

FPT > Templates 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 

 

 

 

 

 

When adding a Template the following information is required: 

 
Name:  The name of the template (ex: Belt Clip Transmitter) 

 

Location:  Leave blank for the template. (This is the text to be displayed when    

an alarm is received from this transmitter (ex: North West hall ) 

 

Receiver:  Identifies the receiver that will be monitoring the transmitter and also 

assigns the repeater it‘s property code, this code comes form the re-

ceiver. (For more information on property codes see the receiver sec-

tion).  When multiple receivers are used in the system, the desired re-

ceiver from the drop down list.   
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FPT Template (continued) 

Alarm Action Tab 

This tab allows you configure relays, intercom stations and or cameras that are 

to be activated when an alarm is received.  Note: A profile must be chosen for a 

template. 

 

 

 

 

 

 
 

 
 
 

 

 

The chosen alarm profile includes information on how the transmitter is to re-

spond when an alarm is received. (Page on Alarm, Page on Acknowledge, Page 

on Reset, Sound On Alarm, Sound Continuously, Auto Acknowledge, Sound File 

Name and time modes for alarm monitoring). 

 

 

Choosing  Relays, Cameras and Intercom stations 
 

Edit Button  Relays, Intercom stations and (or) Cameras that are 

 common to this type of transmitter should be added 

to this template.  Pressing the Edit button next to the 

window will display a list of devices.  Select the de-

sired devices and press the OK button to add your 

choices. 

 

Delete Button  To delete the selected item from the list. 

 

Notes Tab    

The Note tab can be used to enter in any pertinent information regarding the 

template. 
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FPT Transmitters (ADD/EDIT) 
 

Now that profiles and templates have been established, you can begin adding 

transmitters.  FPT transmitters are used in Crisis Controller to send alarms from 

a fixed location. 

 

All FPTs use profiles and templates and these items must be defined before en-

tering any FPT. 

 

FPT > FPTs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Red X   Transmitter needs to be programmed. 

 

Blue Check  Transmitter is programmed. 

 

Add Button To enter information about new transmitters 

 
Edit Button  To edit information about an existing transmitter.  

Note: Some transmitter information changes will re-

sult in a Red X being display next to the transmitter in 

the list. This Red X means the transmitter must repro-

grammed. 

 
Delete Button  To delete the selected transmitter from the system. 

 

Program Button   After all data for the transmitter is configure, the Pro-

gram button is used to load the data into the physical 

transmitter. (See the programming transmitter section 

page 55) 
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FPT Transmitters (Add/Edit) continued  

General Tab 

 

 

 

 

 

 

 

 

 

 

 

 

The following information is required when adding a transmitter: 

 

Template:  Templates are used to create a set of common configuration choices 

that can be applied to multiple transmitters.  Choose the appropriate 

template for the transmitter. Templates contain standard information 

relative to transmitter programming and external equipment inter-

faces. 

 

 

Name:  The name of the transmitter (ex: Wall Transmitter 1) 

 
Location:  Location of the transmitter. This text is displayed when an alarm is 

received from the transmitter. (ex: Visitation) 

 

Receiver:  Identifies the receiver that will be monitoring the transmitter and as-

signs the property code to the transmitter (For more information on 

property codes see the receiver section).  When multiple receivers are 

used in the system, select the desired receiver from the drop down 

list.   

 

 

Transmitters may be entered into the system without choosing a template.   Op-

tions imported from a template may a be altered. 
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FPT Transmitters (Add/Edit) continued  

 
Contact Type:  The Contact type is set to reflect the normal operating condition 

of the transmitter.  If the transmitter uses contacts and is pro-

grammed to alarm on a closed contact, the open contact setting would 

be checked.  Conversely, if the transmitter was programmed to alarm 

on a open contact, the closed contact setting would be checked. 
 

Internal contact 

 This tells the transmitter to the internal contacts on the transmitter 

(Used on Universal Gap Sensor transmitters)  
 

EOL( End of line resistor) 

Use a 1K resistor in circuit that would connect to the transmitter.  
 

Check-in Interval 

The option is used to tell the transmitter how often to send a check

-in transmission (default check-in interval is one minute). 
 

Supervision Interval  

The option is used to tell the Crisis Controller software how long to 

wait for a check-in transmission form the transmitter. If a check-in 

signal is not received in the allotted time window an inactivity 

alarm is posted (default supervision interval is four hours). 
 

 

Alarm Actions Tab 

 

 

Under this tab is were you configure which re-

lays, intercom stations and/or cameras that are 

to be activated when an alarm is received.  

Choose the Correct profile for this transmitter 

form the Drop Down box.  The alarm Profile 

chosen here will include information on how the 

transmitter is to respond when an alarm is re-

ceived:  Page on Alarm, Page on Acknowledge, 

Page on Reset, Sound On Alarm, Sound on 

Alarm Continually, Auto Reset, Sound File Name 

as well as which Pagers to page.  Any settings 

that are configured in the alarm profile can not 

be configured via  the FPT configuration win-

dow.  These settings will need to be configured 

in the FPT alarm profile. 

 

If a template was chosen in the General Tab, the associated profile will have 

been selected and any relays, intercom stations and or cameras will be shown. 



42 

Crisis Controller 5.02 

 
FPT Transmitters (Add/Edit) continued  

Action Tab (continued) 

This tab shows the relay, intercom stations and camera options provided by the 

chosen profile Each entry may be edited to suit the needs of this transmitter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
Edit Button  Add items to the list. To add an item to the list press 

the Edit Button and select the new item form the 

shown window Selected items will have a check in the 

box. Press the OK button to add the list. 

 

Delete Button  Delete the selected item form the list. 

 

 

Notes Tab 

  

 Use this tab for any notes regarding this transmitter. 
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Mobile Transmitters (Add/Edit) 
 

Mobile FPT transmitters are used to provide a way for acquiring the general lo-

cation of a person of object.  Mobile FPTs are strictly used for tracking via RFL 

(Radio Frequency Locators) and can not be tracked via the IRTs used byt eh 

PALS 9000 and L2L transmitters.  The transmitters in use when configuring mo-

bile transmitters are the same ones that are used for regular FPTs.   

 

All Mobile FPTs utilize FPT Alarm Profiles and FPT templates.  FPT Alarm profiles 

must be configured before configuring a mobile FPT.  FPT Templates are not re-

quired, but are highly recommended for initial configuration of all mobile FPTs. 

FPT >Mobile  FPTs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Red X         Transmit ter  i s  not  programmed wi th current                                         

 settings in system. 
 

Blue Check      Transmitter is programmed with current settings in 

 system. 
 

Add Button  To create a new mobile FPT. 
 

Edit Button  To edit the configuration of an existing FPT.  Note: 

Some transmitter information changes will result in a 

Red X being display next to the transmitter in the list. 

This Red X indicates that the transmitter requires re-

programming. 
 

Delete Button  To delete the selected transmitter from the sys

 tem. 
 

Program Button After all configuration settings for the FPT are entered 

into the system, the Program  button is used to pro-

gram the Mobile FPT.  
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Mobile FPT Transmitters (Add/Edit) continued  

 

General Tab 

 

 

 

 

 

 

 

 

The following information is required when adding a mobile transmitter: 

 

Template:  Templates are used to create a set of common configuration choices 

that can be applied to multiple mobile transmitters concurrently.  

Choose the appropriate mobile template for this transmitter. The tem-

plate contains the following settings for FPT programming:  Name, 

Contact Type, Check-in Interval, Supervision Interval, Default Re-

ceiver, any relays, intercom stations and or cameras to be activated 

by an alarm. Templates also contain an Alarm Profile to use).  For 

more information on templates and profiles see the FPT template and 

profile section.  

 

 

Name:  The name of the transmitter (ex: Desk alarm Pendant) 

 
Location:  For Mobile transmitters, the location is left blank. 

 
Receiver:  Identifies the receiver that will be monitoring the transmitter and also 

assigns the transmitter it‘s property code  (For more information on 

property codes see the receiver section).  When multiple receivers are 

used in the system, select the desired receiver from the drop down 

list.   

 

 

 

Transmitters may be entered into the system without choosing a template.   

Options imported from a template may be altered. 
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Mobile FPT Transmitters (Add/Edit) continued  

 

Contact Type:  The Contact type is set to reflect the normal operating condition 

of the transmitter.  If the transmitter uses contacts and is pro-

grammed to alarm on a closed contact, the open contact setting would 

be checked.  Conversely, if the transmitter was programmed to alarm 

on a open contact, the closed contact setting would be checked. 
 

Internal contact 

This tells the transmitter to the internal contacts on the transmitter 

(Used on Universal Gap Sensor transmitters)  
 

EOL( End of line resistor) 

Use a 1K resistor in circuit that would connect to the transmitter. 
 

Check-in Interval 

The option is used to tell the transmitter how often to send a check

-in transmission (default check-in interval is one minute). 

 

Supervision Interval  

The option is used to tell the Crisis Controller software how long to 

wait for a check-in transmission form the transmitter. If a check-in 

signal is not received in the allotted time window an inactivity 

alarm is posted (default supervision interval is four hours). 

 

Alarm Actions Tab 

This tab allows you to configure relays, intercom stations and/or cameras that 

are to be activated when an alarm is received.   

 

Choose the Correct profile for this transmitter 

from the Drop Down box.  The alarm Profile 

chosen here will include information on how 

the transmitter is to respond when an alarm is 

received:  Page on Alarm, Page on Acknowl-

edge, Page on Reset, Sound On Alarm, Sound 

on Alarm Continually, Auto Reset, Sound File 

Name as well as which Pagers to page.  Any 

settings that are configured in the alarm pro-

file can not be configured via  the FPT configu-

ration window.  These settings will need to be 

configured in the FPT alarm profile. 

 

 

If a template was chosen in the General Tab, the associated profile will have 

been selected and any relays, intercom stations and or cameras will be shown. 
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Mobile FPT Transmitters (Add/Edit) continued  

 

Action Tab (continued) 

The  relay, intercom stations and camera options provided by the chosen profile 

may be edited to suit the needs of this transmitter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Edit Button Add items to the list. To add an item to the list 

press the Edit Button and select the new item 

form the shown window Selected items will 

have a check in the box. Press the OK button to 

add the list. 

 

Delete Button   Delete the selected item form the list. 

 

 

Notes Tab 

 

 Use this tab for any notes regarding this transmitter. 
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Programming Transmitters 
 

In this Section, an FPT transmitter will be used. This method of programming is 

also applicable to mobile FPTs, Repeater and RF Locators. 

 

FPT>FPT> Program button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Programming Instructions for an FPT Transmitter: 

 

1. Select the transmitter from the list. 

2. Press the program button. The Program window will appear. 

3. Attach the transmitter to the programming header.  The programming 

header is a 2-pin header that is attached to the Serial Receiver cable.  

The programming cable should be attached with the red wire con-

nected to the middle pin of the 3 pin programming header.  Press the 

reset button on the Transmitter (for the location of each Transmitters‘ 

reset button, see the individual Transmitter user manuals) and wait 

for verification beep from the Receiver.  
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Programming a transmitter (continued) 

 

 

After the reset button is pressed and programming is successful, the following 

message will display: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Press the Close Button and a blue check mark will appear to the left of the 

transmitter indicating that the transmitter was programmed.  Note: If the pro-

gramming was unsuccessful a error message will be displayed. 

 

Transmitters contain non-volatile memory for configuration settings.  Once a 

transmitter is programmed, the programming will be retained.  When batteries 

are replaced, simply insert the new battery and press the reset button on the 

transmitter.  
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FPT People 
 

This menu contains a list of the people that will carry the Mobile FPT transmit-

ters and the PALS9000, L2L transmitters. These people can me associated with 

a particular transmitter so when an alarm is received information about the per-

son may be viewed. 

 

 

FPT>People 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add Button  To add a new person to the list so the person can be 

assigned a transmitter 
 

Edit Button  To edit information about the selected person 
 

Delete Button  To delete the select person from the system 

 
Close Button  To close the window. 
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FPT People Add/Edit (continued) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following information is required when adding people into the system: 

 

Code/ID:  This is a unique alpha-numeric number/id for each person being 

added. Employee id (ex: 12345) 

 

Name:  Name of the person being added.  The remaining fields are optional. 

 
Photo Button:  A photo may be added for better identification of the person. 

Press the photo button to added the desired photo the persons infor-

mation. 

 

 

Visitor Check Box:  This box is here to allow you to quickly identify if this  per-

son is a employee or a visitor to your facility. 

 

 

Notes Tab:  Use this space to but add relevant information about the person. 
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FPT Groups 
Transmitter Groups are collections of transmitters that may be enabled or dis-

abled.  For example, if the Crisis Controller® software were monitoring a profes-

sional office building, Operators could selectively arm vacant offices, while dis-

arming public access areas and offices that were still occupied.  

 

FPT>Groups 

 

 

 

 

 

 

Add Button   To add a new Group 
 

Edit Button   To edit an existing group 
 

Adding/Editing a group 

 
 
 
 
 
 
 
 
 
 
Name The Name identifies the group to the system 

and the user. 

 

Edit Button   To edit the list of transmitters. 

 

Delete Button To delete a transmitter from the group. 
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FPT Groups (continued) 

 

To add a transmitter to the displayed list, press the Edit Button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now select the desired transmitter for this group from the list by checking the 

box next to the transmitter. When complete, press the OK button 

 

 

Transmitter Groups are manually enabled or disabled in Alarm Monitoring mode. 
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PMT PALS 9000/L2L 
 

A Personal Mobile Transmitter (PMT) is an IR/RF based unit used to locate an 

individual in a duress situation.  The PMT stores the current and previous loca-

tions obtained from IRTs.  When the PMT goes into alarm, this information is 

included in the alarm transmission, permitting the PALS  monitoring system to 

indicate current and previous locations on a map.  PALS 9000 and L2L PMTs are 

configured and programmed the same way. The difference between the 

PALS9000 and the L2L is that the L2L does not have the Pull-Cord, Person 

down, Slide switch or beep options. 

 

Both the PALS9000 and the L2L PMTs use profiles and templates and these 

items must be defined before configuring a PMT. 

 

Defining a PMT Profile 
The options available in a profile determine how the software will respond when 

an alarm is received transmitter. Profiles also allow global changes to the op-

tions to all PMTs assigned to the profile. 

 

 PMT >Alarm Profiles  

 

 

 

 

 

  

 

 
 

 
 

 
 

Add Button    To add a new profile.  

 

Edit Button  To edit an existing profile.  Highlight the 

profile and press the Edit button 

 
Delete Button  To delete a profile from the system.   

 

If the profile is being used by any transmitter the profile can not be deleted. 
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PMT Alarm Profile (continued) 

 

The General Tab 

 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
When adding a Profile the following information is required: 

 

Name:  The name to identify the profile (Different PMTs may use the same pro-

file) 

 
Page on Alarm:  When the alarm is received send a page to the chosen pager. 

 

Page on  Acknowledge:  When this alarm is acknowledged send a page to the 

chosen pager. 
  

Page on Reset: When the alarm is acknowledged send a page to the chosen 

pager. 
 

Sound on Alarm  
 When the alarm is received play the chosen sound file. 

 

Sound Continuously: When the alarm is received continue to play the chosen 

sound file until the acknowledged button is pressed.  Note: If this op-

tion is not selected the sound file will play only once. 

 
Auto Acknowledge:  When the alarm is received the system will automatically 

acknowledge and reset the alarm after thirty seconds. 
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PMT Alarm Profile (continued) 

 

The Time Mode Tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This tab determines which time periods will receive and display alarms. 
(Day, Evening, Night) 
 

 

The Sounds Tab 

   

 

 

 

 

 

 

 

This tab allows the user to select different alarm sounds for different alarm con-

ditions. 
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PMT templates 
 

Defining a PMT Template 
Templates are used as a shortcut to add in transmitter information that is com-

mon to the PMTs that are being added into the system. The template contains 

information on  the way the transmitter is to be programmed; Name, Contact 

Type, Check-in Interval, Supervision Interval, Default Receiver, any relays, in-

tercom stations and or cameras to be activated by an alarm. Templates also 

contain an Alarm Profile to use (see PMT Alarm Profile section for more informa-

tion).   

 

PMT> Templates 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

Add button  To add a new template to the system. 

 

Edit Button             To Edit the selected template. 

 

Delete Button  To delete a template from the system. 
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PMT Templates (continued) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When adding a Template the following information is required: 

 

Name:  The name of the template (ex: PMT General Template1) 

 
Assigned to:  Leave blank for the template or assign to a factious name. (Ex: -

Default Name) 

 

Receiver:  Identifies the receiver that will be monitoring the PMT and also as-

signs the PMT it‘s property code.  When multiple receivers are used in 

the system, select the desired receiver from the drop down list. (For 

more information on property codes see the receiver section).  

 

 

Check-in Interval:  This option is used to configure  the PMT for the time inter-

val in which it is to send a check-in transmission (default check-in in-

terval is twelve minutes). 

 

Supervision Interval :  The option is used to tell the Crisis Controller software 

how long to wait for a check-in transmission from the PMT. If a check-

in signal is not received in the allotted time window an inactivity alarm 

is posted (default supervision interval is four hours). 
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PMT Templates (continued) 

 

Programming Option Tab 

 
The operating parameters of the PMT are set on this tab. 
 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

Alarm Options Section 

 
This section contains which alarms the PMT should transmit. If an alarm is dis-

abled (not checked) the PMT will not transmit that alarm. 

 

Panic Button:  If checked the PMT will send a panic alarm when the panic button 

is pressed. If unchecked the PMT will not transmit the Panic alarm. 

 

Pull Cord:  If checked the PMT will send a Pull Cord alarm when pull cord is re-

moved. If unchecked the PMT will not transmit the Pullcord alarm.  

Note: This option does not apply to the L2L. If this template is for a 

L2L checking or un-checking this option will have no effect. 

 

Person Down:  If checked the PMT will send a Person Down alarm when its is 

tilted more than 60 degrees for the set time period. If Unchecked the 

PMT will not transmit the Person Down alarm.  Note: This option does 

not apply to the L2L. If this template is for a L2L checking or un-

checking this option will have no effect. 
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PMT Templates (continued) 

 

Person Down Options Section 

 

This Section allows you to configure the person down alarm. 

 

Reminder Tone:  If the Person Down feature has been disabled by setting the 

PALS9000 unit into switch position 2, the unit will emit a series of 

―chirps‖ reminding the wearer that the person down function is dis-

abled.  By checking this box, the warning chirp indicating that the Per-

son Down feature is disabled will be activated.   Note: This option 

does not apply to the L2L. If this template is for a L2L checking or un-

checking this option will have no effect. 

 

Silent (Person Down):  If the PMT is tilted (typically 60° +/- 10° from vertical) 

the unit will emit a ―chirp‖.  By checking this box, the Person Down 

warning tone will be sounded.  This feature may be used if indications 

of an alarm transmission might jeopardize personal safety, such as 

correctional environments.  Note: This option does not apply to the 

L2L. If this template is for a L2L checking or un-checking this option 

will have no effect. 

 

Tone Delay:  The Person Down sensor is a tilt switch that will be activated if the 

PMT is tilted past approximately 60°.  When this occurs, the PMT will 

emit a tone warning of a possible Man Down situation.  The tone delay 

interval allows for changes of position due to normal movement or ac-

tivities, such as bending over.  If the device remains in this position 

for a period longer than specified by the delay interval in seconds, an 

alarm will sound.  The Person Down Tone interval should always be 

shorter than the Person Down Alarm.  Note: This option does not ap-

ply to the L2L. If this template is for a L2L checking or un-checking 

this option will have no effect. 

 

Alarm Delay:  If the PMT remains tilted for this programmed period of time, a 

Man Down alarm will be generated.  Note: This option does not apply 

to the L2L. If this template is for a L2L checking or un-checking this 

option will have no effect. 
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PMT Templates (continued)  

 

Chirp Options 

 

The PMT can emit chirp under certain conditions.  Note: These options do not 

apply to the L2L. If this template is for a L2L checking or un-checking these op-

tions will have no effect. 

 

Enable Chirp On TX:  If checked the PMT will chirp (as audible verification) each 

time it transmits alarm information .  A chirp will also be emitted when the PMT 

is sending a check in message. 

 

Enable Chirp On New IR:  If checked the PMT will sound a double chirp when-

ever a new IR Locator is detected.  ―New‖ refers to the first locator signal from 

an IRT that is not the current location.  

 

Enable Chirp On Any Valid IR:  If checked the PMT will sound a single ―chirp‖ 

whenever any IR Locator is detected. 

 

Other Options 

 

Under this section you can configure the PMT to transmit on new IR locator and 

how often to look for new location information.  ―New‖ refers to the first locator 

signal from an IRT that is not the current location.  

 

Transmit on New IR:  If checked, when the PMT wearer passes a new IR loca-

tion, the unit will transmit a signal verifying this.  Un-checking this box the PMT 

will not transmit its new location when a IR has been passed the information will 

be stored into it‘s memory for later use. Location information is always sent on 

supervisory  transmissions. 

 

IR Polling:  Sets the interval at which the PMT looks for an IRT Locator trans-

mission.  Longer intervals may increase battery life slightly, but shorter inter-

vals increase the accuracy of a location. The time period can only be chosen 

form the drop down menu.  The available options are:  0.5, 1.0 and 2.0 sec-

onds. 

 

  

Personal Mobile Transmitters from Actall Security Products ship with default pro-

gramming in the IR Polling, Check in and Supervisory fields.  As is the case with 

all ASP devices, these settings should be customized to complement the system 

layout and the requirements of the facility. 
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PMT Templates (continued) 

 

The Alarm Option Tab 

The alarm Profile chosen here will include information on how the transmitter is 

to respond when an alarm is received (Page on Alarm, Page on Acknowledge, 

Page on Reset, Paged on Sound On Alarm, Sound on Alarm Continually, Auto 

Reset, Sound File Name as well as which Pagers to page.) these option may not 

be changed on individual transmitters. 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 

 

The  relay options provided by the chosen profile may be edited to suit the 

needs of the transmitter. 

 

Any Relays added here will be activated when an alarm is received for this transmit-

ter regardless of location. 

 

Edit Button— Add items to the list. To add an item to the list press the Edit But-

ton and select the new item form the shown window Selected items will have a 

check in the box. Press the OK button to add the list. 

 

Delete Button—Delete the selected item from the list. 

 

Notes Tab 

 

Use this tab for any notes regarding this transmitter. 
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PMT PALS 9000/L2L 
 

 

Defining a PMT 

All PMTs use Profile and Templates these must be defined before entering any 

PMTs into the system.  PALS and L2L units are both programmed in the same 

manner. 

 

PMT > PALS 9000  

PMT > L2L 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Red X  PMT is not programmed with current settings in system. 

 

Blue Check PMT is programmed with current settings in system. 

 

Add Button  To create a new PMT. 

 

Edit Button   To edit the configuration of an existing PMT. (Note: Some 

PMT information changes will result in a Red X being display next to the 

PMT in the list. This Red X indicates that the PMT requires reprogram-

ming.) 

 

Delete Button  To delete the selected PMT from the system. 

 

Program Button  After all configuration settings for the PMT are entered 

into the system, the Program  button is used to program the data into the 

PMT. 
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PMT (Add/Edit) 

The General Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A template is not required to be used but the correct alarm profile must be chosen 

on the action tab.   

When entering in PMT transmitters,  the following information can be entered 

manually (or filled utilizing  a template): 

  

PMT Template:  Choose the appropriate template for this transmitter.  The tem-

plate contains information on  the way the transmitter is to be programmed 

like: Assigned to,  Check-in Interval, Supervision Interval,  Receiver, any relays, 

intercom stations and or cameras to be activated by an alarm. Templates also 

contain an Alarm Profile to use.  For more information on templates and profiles 

see the PMT template and profile section.  

 

Transmitters may be entered into the system without choosing a template.  Op-

tions imported form a template may be altered. 

 

Serial Number:  This field can not be edited. This field is used  for the bar-

coding function. 

 

ID:  This number is generated by the system. The ID number may be changed if 

necessary the Serial Number field will change accordingly. Duplicate IDs are not 

allowed by the system. 

 
Assigned to:  The name of the  user for this transmitter. 

 

Receiver:  Identifies the receiver that will be monitoring the PMT and also as-

signs the PMT it‘s property code. (For more information on property codes see 

the receiver section).  When multiple receivers are used in the system, select  

the desired receiver from the drop down list. 
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PMT (Add/Edit) 

The Programming Tab 

 

Operating parameters of the PMT are set in the Programming  tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This tab is not displayed for the L2L all of the programming option are shown on 

the General Tab under the Programming section. 

 
This section contains which alarms the PMT should transmit. If an alarm is dis-

abled (not checked) the PMT will not transmit that alarm. 

 

Panic Button:  If checked the PMT will send a panic alarm when the panic button 

is pressed. If unchecked the PMT will not send this alarm. 
 

Pull Cord:  If checked the PMT will send a Pull Cord alarm when the pull cord is 

removed. If unchecked the PMT will not send  this alarm.  This option does not 

apply to the L2L. 

 

Person Down:  If checked the PMT will send a Person Down alarm when the PMT 

is tilted more than 60 degrees for the set time period. If Unchecked the PMT will 

not send  this alarm.  This option does not apply to the L2L. 
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PMT (Add/Edit) (continued) 

Person Down Options Section 
 

This Section allows you to configure the Person Down alarm. 

 

Reminder Tone:  If the Person Down feature has been disabled by setting the 

PALS9000 unit into switch position 2, the unit will emit a series of ―chirps‖ re-

minding the wearer that the person down function is disabled.  By checking this 

box, the warning chirp indicating that the Person Down feature has been deacti-

vated will be enabled.  This option does not apply to the L2L. 

 

Silent (Person Down):  If the PMT is tilted (typically 60° +/- 10° from vertical) 

the unit will emit warning tones prior to going into an alarm state.  By checking 

this box, the Person Down warning tones will not be sounded.  This feature may 

be used if indications of an alarm transmission might jeopardize personal safety, 

such as correctional environments.  This option does not apply to the L2L. 

 

Tone Delay    

The Person Down sensor is a tilt switch that will be activated if the PMT is tilted 

past approximately 60°.  When this occurs, the PMT will emit a tone warning of 

a possible Man Down situation.  The tone delay interval allows for changes of 

position due to normal movement or activities, such as bending over.  If the de-

vice remains in this position for a period longer than specified by the delay in-

terval in seconds, an alarm will sound.  The Person Down Tone interval should 

always be shorter than the Person Down Alarm..  This option does not apply to 

the L2L. 

Alarm Delay 

If the PMT remains tilted for this programmed period of time, a Man Down 

alarm will be generated.   This option does not apply to the L2L. 
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PMT (Add/Edit) (continued) 

 

Chirp Options 
The PMT can emit chirp under certain conditions. 

 

Enable Chirp On TX 

If checked the PMT will chirp (as audible verification) each time it transmits 

alarm information . 

 

Enable Chirp On New IR 

If checked the PMT will sound a double chirp whenever a new IR Locator is de-

tected.  ―New‖ refers to the first Locator signal from an IRT that is not the cur-

rent location. 

 

Enable Chirp On Any Valid IR 

If checked the PMT will sound a single ―chirp‖ whenever any IR Locator is being 

detected. 

 

Other Options 
Under this section you can configure the PMT to transmit on new IR locator and 

how often to look for new location information  ―New‖ refers to the first locator 

signal from an IRT that is not the current location.  

 

Transmit on New IR 

If checked when the PMT wearer passes a new IR location, the unit will transmit 

a signal verifying this.  Un-checking this box the PMT will not transmit its new 

location when a IR has been passed the information will be stored into it‘s mem-

ory for later use. Location information is always sent on supervisory alarm 

transmissions. 

 

IR Polling 

Sets the interval at which the PMT looks for an IRT Locator transmission.  

Longer intervals may increase battery life slightly, but shorter intervals increase 

the accuracy of a location. The time period can only be chosen form the drop 

down menu. 
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PMT (Add/Edit) (continued) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Alarm Actions Tab 
The alarm Profile chosen here will include information on how the transmitter is 

to respond when an alarm is received (Page on Alarm, Page on Acknowledge, 

Page on Reset, Paged on Sound On Alarm, Sound on Alarm Continually, Auto 

Reset, Sound File Name as well as which Pagers to page.) these option may not 

be changed on individual transmitters. 

 
The  relay options provided by the chosen profile may be edited to suit the 

needs of this transmitter. 

 

Any Relays added here will be activated when an alarm is received for this trans-

mitter regardless of location. 

 

Edit Button:  Add items to the list. To add an item to the list press the Edit But-

ton and select the new item form the shown window Selected items will have a 

check in the box. Press the OK button to add the list. 

 

Delete Button:  Delete the selected item from the list. 

 

 

Notes Tab 
 Use this tab for any notes regarding this transmitter. 
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Programming PMTs 
 

In this Example a PALS 9000 transmitter we be used. The method of program-
ming will be the same for L2L‘s 
 

PMT>PALS 9000> Program button 

PMT>L2L> Program button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To program a PMT transmitter : 

 

 1) Select the transmitter from the list. 

 2) Press the Program Button. The program window will appear. 

 3) Attach the transmitter to the programmer. 

The Programmer is a Black cord with a USB Connector and a cord with a 1/4 ― 

stereo jack attached. The COM port to which the programmer is attached is de-

fined in the Tools > Options general tab. 

 

If programming is successful the following screen will be displayed: 
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 IRT Locators 
  

IRT Locators are special infrared transmitting devices that transmit ID codes 

that are received by the PMTs.  The ID code is used to identify the alarm loca-

tion or zone from which the alarm originated.  Location information is subse-

quently encoded into the transmissions from the PMT to the Crisis Controller 

system.  This allows for the ability to monitor position and movement of indi-

viduals carrying a PMT on site.  IRT Locators continuously transmit Locator data 

code via infrared light.  The PMT includes an infrared Receiver that is activated 

at regular intervals.  If the PMT is within the coverage area of a Locator, infra-

red data from the Locator is read and stored in the PMT, then included in status 

transmissions to the Crisis Controller system.  IRT Locators may be positioned 

anywhere on a site. 

Adding/Editing IRT Locators 

PMT > IRT Locators 

 

 

 

 

 

 

 

 

 

 

Add Button  Use this button to add a IRT locator information    

 to the system. 

 

Edit Button  Use this button to Edit the selected IRT locator in the 

    list 

 

Delete Button  Use this button to delete a IRT locator from the sys 

    tem 

 

IDs of 64512-65535 will cause PMTs to automatically send a check-in transmis-

sion. This will update the location in the Crisis Controller software.  (This feature 

is only available only on PMTs shipped after January 2003).           
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IR Locator (add/Edit) (continued) 

 

General Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When Adding an IR locator to the system the following information is required: 

 

Identity Options 

 

Name:    This Field cannot be edited. 
 

ID:   Select an ID number via the scroll box.  This ID number 

must match the number programmed into the IRT.  
 

Location:    Enter the location name of the locator. This is the text that is 

   shown when an alarm is received from this location 
 

Is Entry Exit:   Check This Box to let the Crisis Controller software interpret 

   newly received data as indicating movement from a indoor 

   zone to a outdoor zone.  Crisis Controller will now use RF lo

   cation data as current location when an alarm is received.   

 

Use in conjunction with RF Locators only, if an IRT is mounted at an entry/exit 

point, it must be designated as a entry/exit location In order to utilize RF location.   

 

No Supervision: Usually used at site entry/exit locations.  When the system 

sees that a PMT has reached this location, the system will no 

longer supervise the unit.  For example, if employees take 

PMTs home with them, they need to go through a location 

that tells the system to stop monitoring for check in mes-

sages from the PMT.  When the PMT receives a signal from 

the IRT without this feature enabled the system will start 

monitoring for check in messages. 
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IR Locator (Add/Edit) (continued) 

 

 
Ignore Alarm:  While a PMT is ―at‖ this location, the system will not 

    annunciate any alarms from the PMT.  This setting is 

    intended for use at PMT test stations.  

 

 

The system will still activate any relays assigned this location. 

 

Alarm Actions Tab 

 
Under this tab is were you configure which relays, intercom stations and or 

cameras that are to be activated when an alarm is received form this location.   

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

Edit Button  Add items to the list. To add an item to the list press 

    the Edit Button and select the new item form the  

    shown window Selected items will have a check in the 

    box. Press the OK button to add the list. 

 

Delete Button  Delete the selected item form the list. 
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IR Locator (Add/Edit) (continued) 

 

Pager Tab 

This tab displays what pagers are to be paged when an alarm is received from 

this location. 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 

 
 
Edit Button  Add items to the list. To add an item to the list press 

    the Edit Button and select the new item form the  

    shown window Selected items will have a check in the 

    box. Press the OK button to add the list. 

 

Delete Button  Delete the selected item form the list. 
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Programming IRTs 
 

IRT TESTER/PROGRAMMER 

(#60703) 
 

The 60703 is used to program IRTs with their ID value and to ver-
ify that programmed units are transmitting the correct value. Val-

ues are displayed on the LCD readout, and navigation is accom-
plished via the five buttons and thumb wheel. A 3-pin program-

ming output is available for attaching the programming cable. The 
60703 is powered by one 3V Lithium battery (CR123A).   

 

Turning the IRT Tester ON/OFF  

The 60703 is powered on or off via the thumbwheel on the side of the unit. NOTE: It is 
necessary to pause between powering the 60703 OFF and ON to allow the LCD crystal to 
initialize properly. Adjusting Contrast The LCD contrast can be adjusted once the IRT 
Tester is on, by continuing to turn the thumbwheel until the desired contrast level is 
achieved.  
 

Operational Modes 

The MODE button (#1) controls the principal functions of the 60703. The IRT Tester op-
erates in two modes: Test and Program. Upon receipt, the 60703 will power up in Test 

mode. Thereafter, the unit will power up in the last mode used when turned off. Chang-
ing between modes is accomplished by pressing the MODE button until the desired mode 
is displayed in the LCD screen. 

 

Test Mode 

When pointed at an Infrared Transmitter, Test Mode will read the IRT‘s programmed ID 
and display the value on the LCD screen. When in Test mode, the LCD screen will dis-
play ???TESTING??? (may be a dash)  and show the ID number of the IRT being tested 
on the second line of the display. If no IRT is read, the ID value will be NO IR. 
 

Program Mode 

Use Program mode to program IRTs with the appropriate ID value (i.e. 1 – 65535). 
When in Program mode, the LCD screen will display ???PROGRAM??? and show the ID 
value of the IRT to be programmed on the second line of the display. 

 

Programming an IRT 

Once the unit is in Program mode, attach the three pin cable (included) to the program-
ming output (# 6) Enter the desired ID value by using the left (3) or Right (4) key to 
move to the desired field. Use the Up (5) or Down (2) keys to increase or decrease the 

values in the chosen field. Continuously pressing either the Up or Down keys will enable 
the scroll functionality in that field. (NOTE: IRTs can also be programmed via the Auto ID 
option shown below) Attach the other end of the programming cable to the programming 
header on the IRT (Note: IRT must be powered up). The 60703 will beep and display 
that the Programming was successful once complete. 

 

programming a IRT. 
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Programming IRTs 

 

Programming with Auto ID 

You can enable Auto ID Mode when the Mode button is pressed again in Program Mode. Upon 
pressing the Mode button, the LCD display will display AUTO ID? And prompt you to choose Yes or 
No on the second line of the display. To enable or disable Auto ID, simply choose Yes or No by 
pressing the Left (3) or Right (4) buttons, respectively. Auto ID mode will automatically advance 
the IRT ID number to be programmed by one after successfully  
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Entering People 
 

This menu contains a list of the people that will carry the Mobile FPT transmit-

ters and the PALS9000, L2L transmitters. These people can me associated with 

a particular transmitter so when an alarm is received information about the per-

son may be viewed. 

 

PMT > People 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
Add Button   Use this button to add a new person. 
 

Edit Button   Used this button to edit information about the 

     selected person. 
 

Delete Button   Use this button to delete the selected person 

     from the system. 

 

Close Button   Use this button to close the window. 
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PMT People Add/Edit (continued) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following information is required when adding people into the system: 

 

Code/ID:   This is a unique alpha-numeric number/id for each person being  

  added. Employee id (ex: 12345) 

 

Name: Name of the person being added.  The Following fields are optional 

  Address,  City,  State,  Zip,  Phone 

 

Photo Button:  A photo may be added for better identification of the person.  

  Press the photo button to added the desired photo the persons in

  formation. 

 

 

Visitor Check box:  This box is here to allow you to quickly identify if this person 

  is a employee or a visitor to your facility. 

 

 

Note Tab: Use this space to enter any relative information about this person. 
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Guard Routes 
 

The Guard Route feature of the Crisis Controller® software permits users to des-

ignate timed patrol circuits.  Personnel carrying specially assigned PMTs are 

monitored by the system as they cover a precise course.  The system tracks the 

order of the IRT Locators which are reported and monitor the time interval be-

tween stations.  Delays from the allotted time between stations or from the 

route prescribed causes an alarm.  A Guard Route is defined by listing a se-

quence of locations. 

 

PMT > Guard Routes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Add Button  Use this button to add in a new guard route to the  

    system. 

 

Edit Button  Use this button to edit the selected guard route. 

 

Delete Button  Use this button to delete the selected guard route  

    from the system. 
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Guard Routes (Add/Edit) (continued) 

 

Main Tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

When creating a guard route the following information is required: 
 

Name:  This identifies the guard route to the user and the system. 

 

Location:   This location is either the first location in the list or the next 

   location the person will need to get to before the allotted  

   time period has expired. 

 

Time From last location:  The amount of time the person will have from the last 

   location in the list to this location. 
 

 
 

 
 
 
 
 
 
 
 
 
 

 
 
 

Delete Button  Use this button to remove a location form the guard 

    route. 

 

Add Button  Use this button to add new location information to the 

    guard route.  When adding a location to a guard route 

    select the location form the drop down list.  
 

The operator can now start the Guard Route. 



80 

Crisis Controller 5.02 

 

Maps 
 

The Maps option is one of the most useful features in the Crisis Controller soft-

ware.  When a particular device is being activated, alarm center personnel can 

see the location of the alarm on a map of the site.  The sub-map capability per-

mits users to ―zoom‖ in on sites in increasing detail.  For example, an initial 

alarm can be programmed to indicate a building from which the alarm origi-

nated.  A user can click on the map to get a detailed map of the interior of the 

building, and click again to get details of particular areas.   

 

Maps are prepared in drawing programs which can export .BMP or .JPG files. 

Windows® Paint program is available to most Windows® users and cre-

ates .BMP files. 

 

Tools > Maps 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Layout Button  Use this button to edit the IRT, FPT, Repeater, 

     RF locator, Receiver and Input icon position on 

     the maps. 

 

Add Button   Use this button to add a new map to the sys 

     tem. 

 

Edit Button   Use this button to Edit the selected maps file 

     name and path. 

 

Delete Button   Use this button to delete the selected map form 

     the system. 
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 Maps (Add/Edit) 

 

The Add/Edit buttons 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When Adding maps to the system the following information is required: 

 

The first map added to the system is the fist map that is displayed (i.e.: overview 

map or sitemap) 

 
Name:  This identifies the map to the system and the users. 

 

Path:   This is the path to the selected file. Use the Browse button to 

   locate the file. 
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Map Layout 

Map Layout Button 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Map:  Use this Drop Down box to select different map to edit. 

 
Group: Use this Drop Down box to change the type of device to add to the 

  map (FPT, Repeater, RF locator, Relay Input, IRT locator or Sub 

  map) 

 
Items: Use this Drop Down box to select the desired FPT transmitter, IRT 

           locator,  lay or Submap to add to the map 

Items that have been added to the map will no longer appear in the ―Items‖ drop down 

box. 

 

Add Button Use this button to add the device shown in the ―Items‖ box  

   to the map. The Icon that represents this device will appear 
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Map layout (continued) 

 
Zoom  Use the zoom drop down list to change the viewing size of 

   the current map (only affective in  map layout). 
 

Plus and Minus (+ -) Buttons  Use these button to change the size 

   of the selected icon. 

 

 To exit Map Layout click the X in the upper right hand corner. 

 
 
 

Submaps (explained) 

 
Submap icons permit the displaying of an additional map which can show 

greater detail. It is recommended before placing sub-maps, a particular area on 

the map is marked graphically that will represent the link to a sub-map.  It is 

also recommended that sub-maps have an area marked for a link back to the 

main map, otherwise you will be unable to return to the main map from a sub-

map. 

 

When in alarm monitoring mode only the submap link that has the current alarm 

location  represented on the submap will be activated. This allows submaps to 

overlay each other. 
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Stations/Map Exclusions 
Tools > Stations 

 

 

 

 

 

 

 

 

 

 

 

 

 

This windows shows you the Name, Hardware Key number, The Key type, What 

version of Crisis Controller and if the computer is running Crisis Controller cur-

rently of  the computers that are networked to the Crisis Controller system. This 

screen is were maps are excluded from a particular station. 

 

Hardware Key Types: 
NFull: All rights, all functions of all classes. 

NRMon: Net Remote Monitor (no hardware attached). 

NMon: Net Monitor  (hardware attached). 

NAdmin: Check in/out, and report generation. No monitoring.

Full: (Non-networked) Full access. 
 

 
 

Map Exclusion Button 

 

Use this button to exclude maps from being dis-

played on  a particular station. 

When maps are exclude form a station any 

alarms that are placed on the map will not be 

shown on the station. 

To exclude a map or maps Select the station and 

press the Map Exclusion button.  In the window 

that appears put a check mark in the box next to 

the map that is not to be shown for the selected 

station. Press ok to OK to exit. 
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Action/Notes 
Tools > Actions 

Tools > Notes 

 

The Action Taken /Notes window appears When alarms are Acknowledged and 

Reset.  Predetermined responses can be entered in to the drop down boxes for 

the attendant to select. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Insert Button    

 Use this button to enter into the list the text type into the edit box. 

 

Delete Button 

 Use this button to delete the selected item form the list 
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Options 
 

The Options Menu allows you to configure settings that control how Crisis Con-

troller functions. 

Tools > Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The General Tab 
 

Day Mode Start Time  The time Day Mode will start. If auto start is un-

     checked  the attendant will have to manually 

     start the Time mode. 

 

Evening Mode Start Time  The time Evening Mode will start. If auto start is 

     un-checked  the attendant will have to manually 

     start the Time mode. 

 

Night Mode Start Time  The time Night Mode will start. If auto  s t a r t  i s 

     un-checked  the attendant will have to manually 

     start the Time mode. 

 

PMT programming port This is the COM port to witch the pmt program-

mer is attached. 

 

Page on Low Battery If checked the system will tell the pager to send 

a page when the low battery alarm is received. 

The pager that is paged will be the one associ-

ated with the (for PMTs the IR location) (FPT will 

page the pager in it‘s associated profile). 

 

Relay Alarm Tracking If this is checked when a PMT changes location 

any relays that  are associated with the new lo-

cation will be activated. 
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Options (continued) 

 

This Tab allows for the global processing of Alarms for all computers. If alarms 

are unchecked the system will not display the alarm 

 

The Alarm Processing Tab 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FPT Alarm Options 

Alarm If unchecked the system will ignore all duress Alarms from 

FPT transmitters (Pendants, Push button boxes, Pull cord 

boxes Universal transmitters) 

Tamper If unchecked the system will ignore all duress Alarms from 

FPT transmitters (Pendants, Push button boxes, Pull cord 

boxes Universal transmitters, Repeater and RF locators) 

PMT Alarm Options 

Panic If unchecked the system will ignore all Panic alarms from 

PMT transmitters (PALS 9000, L2L) 

Pullcord If unchecked the system will ignore all Pullcord alarms from 

PMT transmitters (PALS 9000) 

Person Down If unchecked the system will ignore all Person Down alarms 

from PMT transmitters (PALS 9000) 
 

General Alarm Options 

Supervision If unchecked the system will ignore all Supervision alarms 

from all system transmitters.  

Low battery If unchecked the system will ignore all Low Battery alarms 

from all system transmitters. 
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Options (continued) 

 

The Printer Output Tab 
 

The tab lets you configure alarm information to be outputted to a dot matrix 

printer and or a serial port. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Log to Printer box If this box is checked all alarm information will be sent 

to the printer on the chosen port. 

 

Printer Port   The physical port the printer is connected to 

 

Lines per Page The number of line per page for your printer (default 

is 66). 

 

Printer Initialization Codes This box is provide to send any required codes 

to your printer. (most printer by default do not use 

any codes) 

Serial I/O 

Send Serial I/O box If this box is checked the system will send alarm data 

out the chosen serial port. 

 

Serial I/O Port  This is the serial port the data will be sent to. 

 

 For more information on serial I/O contact Actall Corp. 
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Options (continued) 

The Network Tab 
 

This Tab allows you to configure each system to send and receiver network 

data.  The settings configured under this tab are local to the system that the 

configuration is preformed on. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inbound 

 

Receive Data Allows Crisis Controller to receive alarm information 

over the network. 

 

Receive Acknowledge Allows Crisis Controller to receive alarm Acknowledges 

over the network. 

 

Receive Reset Allows Crisis Controller to receive alarm resets over 

the network. 

 

Out Bound 

 

Send Data Allows Crisis Controller to send alarm information over 

the network. 

 

Send Acknowledge Allows Crisis Controller to send alarm Acknowledges 

over the network. 

 

Send Reset Allows Crisis Controller to send alarm resets over the 

network. 
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Options (continued) 

The Location Logging Tab 
 

This tab allows you to enable or disable location logging of PMTs.  The settings 

configured under this tab are local to the system that the configuration is pre-

formed on. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Do logging Box  Check this box to start location logging. 

 

Directory The directory (folder) that the data is logged to. (The 

folder must exist in order to be used) 
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General Crisis Controller Main Screen 
 

After logging into Crisis Controller, the Main menu option will be available. The 

drop down menus are as follows: 
 

 Not all Menu options are available for all attend levels 

 

 

 

 

 

 

 

 

 

 

Main Menu Options 

 

File  Login- Change the current user. 

  Exit-  Exit the system (Actall Special user and password need to exit the 
   system). 
 

FPT  Access to FPT, Mobile FPT transmitters and related options. 
 

PMT  Access to PALS 900 L2L transmitters, IRT and related options. 
 

Devices- Access to Receives, Repeaters, RF Locators, Cameras, Intercom Station, 
  SIO32 cards and related options. 
 

Admin- Access to PMT assignment menus. 
 

Tools  Access to Map and Mapping functions as well as other system options. 
 

Monitor Start and stop alarm monitoring mode. 
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General Crisis Controller Screen (continued) 

 
Report– Access to system reports. 
 

Window-Allows the user to arrange the open windows 
 

Help– Access to the Help file and Crisis Controller version information. 

 

Status Bar Windows  (bottom of the screen) 
There are five windows on the status bar that contain information. From left to 

right they are 

 

1 Not used 

 

2 Current attendant logged into Crisis Controller 

 

3 Current database 

 If you mouse over the window the path of the database will be shown. 

 There are three possible database that may be shown 

 

These files should be only configured by Actall Corp the support.  Changes in these 

files may cause the system to not function correctly. 

1) Primary Database (for networked system only) 

This database is the network database configured in the 

(Actall.CrisisController.FormsUI.exe.config) file. 

 

2) Backup database  (for networked system only) 

This database is the network backup database configured in the 

(Actall.CrisisController.FormsUI.exe.config) file. 

  

3) Local Database (stand alone and network versions) 

T h i s  d a t a b a s e  i s  t h e  d a t a b a s e  c o n f i g u r e d  i n  t h e 

(Actall.CrisisController.FormsUI.exe.config) file. 

  

4 Current system date. 

 

5 Current system time. 

 

More on Database Use 

 

If the Crisis Controller system is operating in as a network version, the software 

will monitor the network and database connectivity.  In the event Primary data-

base connection fails the system will display a warning screen stating the data-

base is no longer found. The system will then look for the backup database   

(located on any computer running Crisis Controller). If the backup database can 

not be located the system will revert to it‘s local backup copy of the database. 

When the fault is corrected the system can than be reconnect to the primary 

database.  
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General Crisis Controller Screen (continued) 

 

More on Logons 

 

The Crisis Controller logon window allows you to change the current on the sys-

tem. 

 

File > Logon 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In order to login to the Crisis Controller system you will need a user name and 

password. These are setup by attendants with Supervisor rights (see the tools 

section on page xxx) 

 

To logon to the system choose tool > logon and the above screen will be shown. 

Enter in your attendant name and password 

 example 

  NAME   Operator 

  PASSWORD  1234 

 

If a password or user name is forgotten a Supervisor attend will have to furnish 

you with a new password or tell you your  logon name. 

 



97 

Crisis Controller 5.02 

 

Alarm Monitoring 
 

When alarm monitoring is started the Crisis Controller system will now receive 

alarms from transmitters and execute the programmed repose for the alarm re-

ceived. Depending on attendant  type (Operator or Supervisor) and permissions 

set for the attendant more tabs and monitoring options are available.  To start 

alarm monitoring mode go to the main menu and chose Monitoring > Start the 

following screen will be shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Alarm Status Tab 
Under this tab will be displayed any alarms received by the Crisis Controller sys-

tem. When alarm are received select the desired alarm from the list. The se-

lected alarm can display in two colors: 

 

 1)  RED    The  current alarm has not be acknowledged by the 

    attendant. 

 

 2)  YELLOW The current alarm has be reset by an attendant. 

 
Acknowledge Button 
 
 Use this button to acknowledge the selected alarm that have be received.  

 

Reset Button 
 Use this button to reset the selected alarm. 
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Alarm Monitoring (continued) 

 

 

Alarm Status window headings 
 

Date/Time  Displays the date and time the selected alarm was received. 

 

Name The name associated with the transmitter.  If the transmitter 

is a FPT this field is the static text entered into the name 

field of the FPT. If the transmitter is a mobile FPT,PALS 9000 

or a L2L this is the assigned name for this transmitter. 

 

Location  The current location of the selected transmitter. 

 

Reason This is the type of alarm form the transmitter.  FPT transmit-

ters can display Alarm, Tamper or Inactive. PALS 9000 or 

L2L can display Panic, Pull-cord,  Persondown or Inactive. 

 

Status This show if the selected transmitter has been Acknowledged 

and Reset by the attendant. 

 

ID   Displays the Transmitter programmed ID number. 

 

Restored  Displays if the Transmitter has returned to its normal state 

(True or False). If the alarm remains after being reset check 

this field for the reason of the no-reset. 

 

 

 

Example: After and Pull Cord alarm has been received for a PALS 9000 

transmitter. The attendant can  acknowledged and reset  but the alarm 

remains displayed in the alarm status  window.  The cause could be that 

the pull cord break has not been reinserted into the transmitter. The 

alarm will remain on the display until the transmitter has been returned 

to its normal state, after doing so the transmitter will transmit a OK sig-

nal which Crisis Controller will receive and then clear the alarm.  

 
 

 

 

 



99 

Crisis Controller 5.02 

 
Alarm Monitoring (continued) 

 

The Monitoring Menu Option 
 

While monitoring there are several options available for the attendant to help in 

the processing of alarms. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Stop   Stop Alarm Monitoring Mode. 
 
Layout   Allows the user to change the view of the monitoring screen 
 

Time Mode  Activate or deactivate a time Mode. 
 

Send Page  Send a page to a pager . 
 

FPT Groups  Activate or deactivate a FPT group. 
 

Guard Routes Activate a Guard Route. 
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Alarm Monitoring (continued) 

 

 

More information on the Monitoring menu options 

 

Time Modes 

 
 

 

 

Send Page  

 

 

 

 

 

 

 

 
 
FPT Groups 
 
FPT Groups are Transmitter that have been grouped together  in order to easy 

control if alarm should be accept or ignored by the system. To enable (Accept 

alarms) or Disable (ignore alarms) for a  group simply select the group desired 

fro the Drop Down box and press the Enable or Disable Button.  Once a group is 

disabled alarms will not be displayed  until 

it is enabled again. 

 

 

 

 Re-Starting Monitoring mode will enable 

all FPT groups. 

There are three time modes available in Crisis 

Controller (Day, Evening and Night) certain 

type of alarms may be ignored in each time 

mode. By activating or deactivating a time 

mode the attendant can tell Crisis Controller 

to accept or ignore alarms. 

Pages can only be sent in monitoring 

mode.  To send a page to a pager select 

the desired pager form the Drop Down 

list. Enter the message in the Message 

window press the OK button. 
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Monitoring Screen Layout 

 

The Crisis Controller software allows the user to set the monitoring screen with different 

panel views. 

 

Alarm Monitoring (continued) 

This is an example 

of Top configuration 

This is an example 

of Split Horizontal 

configuration 
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 Alarm Monitoring (continued) 

Monitoring Screen Layout 

To change the different configurations the system will need to be in 

Monitoring mode.  Once in monitoring mode click on Monitor and move 

down to Layout, as seen below. 

Top View 

Split Horizontal 

The preview pane will show you what the 

configuration will look like after clicking on 

the Accept button. 
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Alarm Monitoring 

When a Supervision alarm comes in, the Operator needs to 

Acknowledge and then Reset the alarm.  The Supervision 

alarm will then move to the Queue window, clearing the 

main screen to allow for duress alarms to show up.   

Alarm Monitoring (continued) 
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Alarm Monitoring 

After clicking on the Acknowledge button the Status will change 

to Acknowledged as shown above.  Now the Operator needs to 

click on the Rest button.  After doing so, this Supervision alarm 

will move to the Queue window as seen below. 

In this example, the PMT was taken off property and can‘t send 

in Check-In messages.  This alarm will stay in the Queue until 

the PMT is brought back to the facility.  Once the devices 

checks in, the alarm will clear from the Queue window. 

Alarm Monitoring (continued) 
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In the example to 

the  r i gh t ,  a  Wa l l 

t ransmitter  alarm 

was received.  The 

name of the trans-

mitter and it‘s loca-

tion are shown in red 

and also show up on 

the map in the bot-

tom left corner.  The 

alarm is waiting to be 

acknowledged and 

reset.   

In the example to 

the right, we clicked 

on Pane l  v i ew to 

change the way the 

alarm is viewed in 

the Alarm window.  

Again, the alarm is 

also shown on the 

map at the bottom 

left. 

Alarm Monitoring 

Panel View 

List View 

Alarm Monitoring (continued) 
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Acknowledging and Resetting Alarms 

Alarm Monitoring (continued) 

After acknowledg-

ing and alarm, the 

box below will ap-

pear.  This box will 

appear i f  Simple 

Ack and Reset are 

NOT checked in the 

Operators settings 

in Attendants (see 

page 8-10). 

After clicking OK on the Alarm Log box, the screen will 

then show the alarm ICON in Yellow.  This means that 

the alarm is waiting for the operator to reset it after 

hearing that the situation has been handled.  
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The operator can now select a pre-programmed re-

sponse or can manually type in a summation for the 

event.  These log entries will appear in the reports 

with a time and date stamp attached to them.  Once 

reset, the alarm screen will clear. 

Resetting an Alarm 

Alarm Monitoring (continued) 
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Barcode Assignments 
 
Crisis Controller® offers the capability to use barcode readers to scan employee 

badges and PMT barcode IDs.  As the employee‘s badge is read by the barcode 

reader, their record will appear on the assignment screen (with photo, if avail-

able).  If the employee is checking out a PMT (i.e. going on duty) the monitor-

ing system will note the activation of the device.  Each time a PMT is assigned, a 

entry is added to the assignment log indicating the PMT assigned, the person 

the PMT was assigned to, date, time, if the PMT was tested, as well as what 

tests were performed on the PMT. 

 

Follow these steps to Assign a PMT to users: 

  

Scan the Employee‘s barcode (Name and picture will appear in the ap-

propriate boxes)  Note:  Cursor does not need to be placed in any par-

ticular box. 

Scan the PMT to be assigned. 

Now the PMT can be tested or assigned without testing.  If you are 

testing for alarm transmission, verify that the PMT has acquired an 

IRT that has been configured to not display alarms.  If all three tests 

are preformed successfully, the PMT will automatically be assigned.  

Now the PMT is assigned to the user and the system will wait for a 

test transmission.  Upon a successful test, the test result boxes for 

each type of alarm will automatically be cheeked. 

If partial or no testing is required upon PMT assignment, the PMT as-

signment barcode (if available) or left clicking on the Assign button 

will assign the PMT to the user. 

 

 

 

 

This window 
appears after 

the person’s ID 

After the PMT barcode 
is scanned, the PMT 

serial number appears 
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Barcoding (continued)  

Creating Barcodes (For PMTs) 

 
To manually override the assignment of PMTs: 

 

Use the pull-down menu to select the person. 

Once the person has been selected, use the pull-down menu to select 

the PMT 

Click the Assign button. 

  De-assignment of PMTs must be done using the manual assignment options (see 

previ  ous)  PMTs will always be formatted as a five digit number.  This is the number 

that is listed during PMT configuration as the PMT serial number. 



110 

Crisis Controller 5.02 

 
Barcoding (continued)  

Creating Barcodes (for People) 

 

 

 

 

 

 
 

 

Barcodes for People that are inserted in Crisis Controller® are create from the 

data shown in the  Code/ID field.  Example: {1002} is valid barcode data for 

the person shown above. The barcode itself is to be a standard ASCII barcode 

(code 128 style).   Note: There are different brackets used to differentiate be-

tween People and PMTs.   Keep in mind, when you are creating the barcodes 

with the barcode software, you will need to add the appropriate bracket.  You 

do not need to use the brackets when entering ID numbers in the Crisis Control-

ler software.  

 

Sample Employee barcode: 

 
 

 
 

 

                                          {     } for people 
Sample PMT barcode: 

 
 

 
 

 
 

                                           [      ] for PMTs 
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